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*Compatibility and System Requirements

Download Endnote Software



What is EndNote?

Reference management software

® Developed by Clarivate Analytics

Personal Reference database
® Storing, managing, and searching for bibliographic references in your private

reference library

Bibliography and manuscript maker

® Formats citations in Microsoft Word with the Cite While You Write ™ feature



How EndNote Works

& e

Books, Journals, Research Create bibliography Report, Manuscript,

Articles, E-database, etc. Thesis, etc.



Compatibility and System Requirements

Operating System Word processor software

Windows * Windows 10 Microsoft Word [CWYW] :
e Windows11l « 2010
« 2013
2016
e 2019
e Office 365 (locally installed desktop version only)

Macintosh * mac0S10.14 Microsoft Word [CWYW] :
* mac0S10.15 « 2016

* macOS11 e 2019

* mac0S 12 » Office 365 (locally installed desktop version only)
* macO0S13

https://endnote.com/product-details/compatibility



https://endnote.com/product-details/compatibility

Download Endnote Software (1)

1. Go to https://softwaredownload.mahidol.ac.th/ (Access through MU-WiFi or VPN)

2. Login with MU Internet account

i
2
"1 W\ Mahidol University I Mahidol University
e ; COcallow vf ths. Lawd
Software ' Sign in
Download m ] E
- .- mq with your Mahidol University Accounts.

::-E;::;:;!:a"tu F\\ Adobe <\ Mat1AB I
uK1SnendeuRaa DANuLolufio:doiasy SPSS x9 wi:m
s:uUVUA IT na:aussau:=Mvo IT (Run

Password

Us:snausuRaalatdus:Tosiasonodo uas

dunasguniatfsufuavAnsduthuavlan lag

IaSalasgusuansahrsu Software LNOSTIU
{AunansuovurSnendsldldoiu Sigﬂ in
m . Forgot password?



https://softwaredownload.mahidol.ac.th/

Download Endnote Software (2)

3. Download an installer compatible with your operating system. (Windows or Mac)

4, Download EndNote key license

O\ UH1DNu1avuhaa .
. ) Mahidol University
WA (Weallow o the Lowd

Mahidol Software License

EndNote 21 for Windows . e
r 3 A\ Adobe { X©
.- 4 Marias SPSS

Microsoft Microsoft Office Application EndNote 21 for Mac . .
Windows B dila
1 t 4

Key License EndNote 21

Antivirus

Key License
VPN

Copyright © 2023 Mahidol University. All rights reserved. E-mail: consult@mahidol.ac.th Phone: 662-849-6022




Get Started with EndNote

*EndNote Library components
*Creating a New Library
*Library Overview

e Journal Term Lists



EndNote Library components

X _

Pin to Quick Copy
ACCESS

Clipboard

T

#F Quick access

I Desktop
4 Download

& Cnelrive

£ This PC
J 30 Objects
I Desktop

== Documents
4 Downloads
J‘.\ Music

= Pirtures
2 items

| My Research Project

Share View
Move to y Delete =
_J
Paste Copy to Rename
=
Organize

» My Research Project »

S
Test.Data

Mew
folder

Mew

L

O

- O >
ﬂ— HH setect al
Select none
Properties
- ) DD Invert selection
Open Select
Search My Research Project

I

Test.enl
EndMote Library
4 bytes

» EndNote libraries are made up of two parts:
- EndNote Library file (*.enl)
- Data folder (*.Data)
These two parts must be kept together to

work correctly.

Keep EndNote libraries on your computer’s
local hard drive. Storing and editing libraries
on a network drive can lead to corruption and

performance issues.

EndNote libraries should never be stored in
cloud-syncing folders such as Google Drive,
OneDrive, etc. Syncing folders corrupt

EndNote libraries over time.



Creating a New Library

1.  Goto File > New... or select Creating a New Library from Set up Endnote Library box.
2. EndNote presents a dialog prompting you to enter a name for your new library.
3. Select the location where you will save the library.
4. Click Save, then the new Endnote library appears as an empty library.
Mew Ref Lik *
Edit References Groups Library Tools o Tewieference Horary
| New... | 1 [El » ThisPC » Documents 3 O Search Docurnents
Upen Library... Lirl+0 Organize - MNew folder S o
Open Shared Library... Ctrtl+Shift+0 & OneDrive ~ Mame B Date modified Type
Open Recent ' o T b Custom Office Templates 24/3/2563 9:43 File folder
15
Cl Ctrl+\W . EndMote 26/4/2564 16:28 File folder
ose s # 3D Objects LDPlayer 2/4/2563 18:19 File folder
I Desktop 2 My Shapes 31/12/2561 13:29 File folder
Set up EndNote Library 2| Documents Zoom 22/3/2563 11:51 File folder
If you already have an EndNote library, please locate it and we'll get it set up. & Downloads
. . J“ Music
Open an existing library
&= Pictures
B videos
Alternatively, you can start from scratch with a new library. 12 05 (C)
Create a new library i Rbe L v £ >
File name: | My EndMote Library.enl 2 -
Save as type: | EndMote Library (*.enl) ~

. Hide Folders

4




EndNote 20 - Te

st.enl

File Edit References Groups

% Sync Configuration

(£ All References

Library Tools

Library Overview

Window Help

All References

El No reference selected

Advanced search

L Recently Added
B Unfiled

W Trash

All References -

0 References

&

v MY GROUPS

Author Year Title Journal Last Updateq

v My Groups
v FIND FULL TEXT
v GROUPS SHARED BY ...

v ONLINE SEARCH

@ Library of Congress

@ LISTA (EBSCO)
@ PubMed (NLM)
@ Web of Science C...

mMore...




Library Overview

Groups panel

shows you
both default
groups and
groups or
group sets that
you create for
your research

projects.

Menu Bar

File Edit References Groups

Sync Configuration

[l All References
L Recently Added
B unfiled

Tl Trash

v MY GROUPS

V Avian Intelligence

{® Avian Cognition

@\ Corvids

® Corvids & Parrots

®\ Parrots

Vv Bats
®\ Chiroptera

{® Echolocation

{® Echolocation OR So..

@ sonar
> My Groups

“V FIND FULL TEXT

v GROUPS SHARED BY OTHERS

Vv ONLINE SEARCH

@ Library of Congress

@ LISTA (EBSCO)
@ PubMed (NLM)

@ Web of Science Core Co...

more...

Search panel to find an item in your library or to query a

remote database for new references to capture.

v| | Contains

v| | Contains

v| | Contains

All References

Simple search Search options v

|E E Arnett, 2013 #2468 Summary Edit

gl [ES|ES

ARS

Journal Last Updated

Evaluating the .. PLoS One 18-Sep-20

Multi-state occ..  PLoS One 18-Sep-20

Hominids and ..  Proceedings of the National A..  18-Sep-20

New Dataont. Zoologichesky Zhurnal 17-Sep-20

Animal intellig..  Zoologichesky Zhurnal 17-Sep-20

Plant classificat.. Plos Computational Biology 17-Sep-20

An autocorrela..  Biological Cybernetics 17-Sep-20

Mechanisms of.. Auk 18-Sep-20

Azure-winged ..  Behavioural Processes 18-Sep-20

American Museum Novitates

Roosting Ecolo.. 18-Sep-20

The Oxford ha..  Oxford Library of Psychology 21-Aug-19

The Role of Ex..  Current Biology 17-Sep-20

Reference List panel shows the individual references stored

in your EndNote library, also known as library records.

pone.0065794.pdf v‘

Evaluating the Effectiveness of an Ultrasonic
Acoustic Deterrent for Reducing Bat Fatalities at
Wind Turbines

E. B. Arnett, C. D. Hein, M. R. Schirmacher, M. M. Huso
and J. M. Szewczak

PLoS One 2013 Vol. 8 Issue 6 Pages e65794
Accession Number: 23840369 PMCID: PMC3686786 DOL:

10.1371/journal. pone. 0065794

Large numbers of bats are killed by wind turbines
worldwide and minimizing fatalities is critically
important to bat conservation and acceptance of wind

APA 6th Copy citation

Arnett, E. B, Hein, C. D., Schirmacher, M. R., Huso, M. M., &
Szewczak, J. M. (2013). Evaluating the Effectiveness
of an Ultrasonic Acoustic Deterrent for Reducing
Bat Fatalities at Wind Turbines. PLoS ONE, 8(6),

e65794. doi:10.1371/journal.pone.0065794

Tab panel
Summary tab

displays a
detailed
overview of a
selected
reference.
Quickly alter
reference
metadata from
the Edit tab.

Preview

panel shows
you how a
reference
would appear
formatted with
a specific

output style.




Journal Term Lists

Journal Term Lists is lists of journal name in full and abbreviated form.
® These lists are used for making correct journal name in reference format.

* Help EndNote works correctly find out the duplicate references.

Recently Added

2 References

Author Year Title Journal

Li, Zhuo; Hirst, Jonathan D. 2020  Computed optical spectra of SARS-CoV-2 proteins Chemical Physics Letters

Li, Z.; Hirst, J. D. 2020 Computed optical spectra of SARS-CoV-2 proteins Chem Phys Lett

*Retrieving reference from various sources may give the journal name in different form.

ScienceDirect*
give full journal name

PubMed*
give abbreviated journal name



Before & After defining Journal Term Lists

s

i ScienceDirect

Give full journal name

Before

Vancouver e Insert Copy b

1. Li Z, Hirst JD. Comup d optical sp of

SARS-CoV-2 proteinsChemical Physics Letters

2020;758:137935.

After

Vancouver ¥~ Insert Copy

1. Li Z, Hirst JD. Comnputed optical spectra of
SARS-CoV-2 proteinsiChem Phys Lett.

2020;758:137935.

Vancouver Style use the abbreviated journal name



Define Journal Term Lists (1)

1. Go to Library > Define Term Lists...
2. In the Term Lists box, select tab Lists, then select Journals

3. Click at Import List...

Library §Tools Window Help Term Lists
Sync .
y Terms Lists
Advanced Search :
. lb My_Project_1.enl - Create List...
ort Library...
_. . . Authors i
Find Duplicates 2 —
Find Broken Attachment Links Keywords Delete List...
Open Term Lists ’
1 Define Term Lists... Ctrl+4
Link Term Lists... Ctrl+3 Delimiters Update List...
Spell Check Ctrl+Y - ' ' Import List. ..
Find and Replace... Ctrl+R Custom Delimiter: | S
Change/Move/Copy Fields Carriage return is always used as a term delimiter, =
Link Lists...
Recover Library...
Library Summary LIiZ




Define Journal Term Lists (2)

4. Browse to G:\Program Files (x86)\EndNote 21\Terms Lists

5. Choose the appropriated term lists files (e.g. BioScience.txt), then click Open to completed.

6. Select tab Terms to view the imported journal lists, then close.

" Open >
T C:\Program Files (x26)\EndMote 200 Terms Lists[ 4 ) Search Terms Lists
Organize « Mew folder tHE > [ 0
I Desktop " =| Anthropology.txt
4 Downloads =] Archaeology.bet
| Astronomy and Astrophysics.tet
@ OneDrive _I . 4 Py
=| BioScience.txt
& This PC =] Chemical bt
: _ lournals X
J 3D Objects =| Economics.bet
I Deskiop =| Humanities.tet
. =| Korean Medical Terms bt ) . .
% Documents - 6231 terms inserted into the "Journals' term list.
=] Lawebet
; Downloads n .
= Medical txt
b Music =] Philosophy.tct
= Pictures =] Physics.tet
H Videos =] Religion.bct
2 05 () =| Zeological Records.txt

W

File name: | BioScience.txt \j Text file (*xt) v

5

Term Lists

Terms  Lists

65231 Journals in the Journals List:

Full Journal

A Trends Guide

AACHN Journal

Aarsheret. Mar. Fisk,
Aarsberetning, NORCONS-RY

Aarsberetning. Statens Kartverk

aarsmelding. Fiskeriforskning

€

Aarsberetning. Morsk Sjoefartsm...
Aarsberetning. Sildolje- og Sildem...

Aarsmelding. Eksportutvalget for...

Abbrevigton 1

Trends Guide
AADHM 1.
Aarsheret. Mor.
Aarsberet, MORI
Aarsberet. Marsl
Aarsberet, S5F
Aarsberet. State
Aarsmelding Eks)

Aarsmelding Fisk
>

Hint: Hold the Ctrl key to select multiple terms

Mew Term...

| e |

Close




Input Data

*Direct Export
*Import PDF

*Manual Typing



Direct Export Import PDF Manual Typing

_E.',.;_';,{:'._rl«.;.\_'ll"'. o e FEdit Refere Groups Library Tools
T ek
e . . B/ UXX Q Save
4 ScienceDirect i ;
- Reference Type |Journal Article ~ |
Author
Year

Pu bkmed .

Part/Supplement

Issue

Pages

Scopus’ o

Epub Date
Date

Type of Article

Google Scholar *




Mahidol eJournal Access (EZproxy)

>  URL: https://ejournal.mahidol.ac.th

Mahidol University > Login with MU Internet account to access subscribed
Library and Knowledge Center e-resource
Mahidol eJournal Access
P > Support all devices all operating systems (Windows,

I'm not a robot

Maclntosh and Linux), smart phone and tablet with
iOS (iPhone / iPad) and Android

firstname.sur (for staff) or u61xxx or g61xxx

type your password

*** Limitation ***

Must follow the links given in library’s website



https://ejournal.mahidol.ac.th/

Mahidol eJournal Access (EZproxy)

https://stang.sc.mahidol.ac.th O:---HE You can access by

1. Select menu E-Resources

% Mahidol University
& Faculty of Science sl e Lot

Stang Mongkolsuk Library and Information Division

to find appropriated

/ﬁ‘ About Us ¥ [|[E-Resources ~ |Library Resources ~ Library Services ¥ Research Help Desk ¥ IT Help Desk ¥ Museum 2 itact us E_Databases, E—JOUI’ﬂa|S Or

Remote access [off-campus] -
CDATABASES s requires login with MU account vial https://ejournal.mahidol.ac.th - E-Books
| 2. Click URL from the top of

E-JOURMALS

E-BOOKS Webpage

Search Guides/ Online Tutorials

Click edournal Access button

Free Trial Databases

Thai Databaszes

Select appropriated

THAI e-journals ua\m JOC fﬁ\)ﬂ U\ ‘ﬂﬂ?i' iausnas

E-THESES E-databases from bottom of
parenTe &u |Pad lWOﬂ'\SﬂﬂU"\
E-NEWSPAPERS & MEDIAS g ’“'”‘ i e webpage

N  E-DICTIONARY

3 I SCO p us ScienceDirect S C ] \/O I Jour';-.ea;((’::::tion EBSCO §E|F|!\|DER < ACsPublications
Co-learning /D | Stang l"//-’_g\\\l eJournal : f nature W"GVY\;:\IE;GELI'IIV @ Springeerk d :%‘%v - BMC ZbM‘ATH-l.OeefT Ovid
\ - . - \

List of Libraries in Thailand

Space , Training \ i Access

e Service (o) W]  GoogleScholar ) turnitin - EndNote™


https://stang.sc.mahidol.ac.th/

. ® o
Direct export: SciencebDire
cienceDirect Journals & Books ® Register

Search for peer-reviewed journal articles and book chapters (including open access content)

o m Advanced search

[#7]
i
C
o
®
>L
)
S
K
=
=
7
/)
@

Keyword

The most relevant research on Novel Coronavirus (SARS-
CoV-2) and related viruses is available for free on
ScienceDirect, and can be downloaded in a machine-

readable format for text mining.

Alternatively, visit the Elsevier Novel Coronavirus

Information Center for general health information and

advice.

Visit the Information Center »




ScienceDirect

Find articles with these terms

Coronavirus

6;&[[?3 nced search ‘

_ Export X
T Download 25 articles 2, Export ed by relevance | date

25 citations selected

45,746 results

L\ Set search alert >hort communication

1or and novel coronaviruses, Coronavirus Disease 20 > Save to RefWorks \ction: what 1s

mowns > Export citation to RIS ‘

Refine by: ertility and Sterility, 16 April 2020, ... S Export ctation to BIbTEX

I:l Subscribed journals

ames Segars, Quinton Katler, ... Jennifer F. Kawwass

» Export citation to text
\bstract v  Extracts »  Export v

Years

[ ] 2022(10)
| ] 2021(12,137)
|| 2020(19,913)

Show more ~

esearch article @ Full text access

-hospital cardiac arrest in patients with coronavirus 2019
esuscitation, 27 January 2021, ...
Dscar J. L. Mitchell, Eugene Yuriditsky, ... Benjamin 5. Abellz

L| Download PDF  Abstract ~  Extracts ~  Export



Direct export: PuUbMed

National Library of Medicine

National Center for Biotechnology Information

Advanced

PubMed® comprises more than 32 million citations for biomedical literature from MEDLINE, life science journals, and online books.
Citations may include links to full text content from PubMed Central and publisher web sites.




hY WCBI FILTERS [A

-
R

TEXT AVAILAEBILITY

ESULTS BY YEAR

[ ] Abstract
[ ] Free full text
[ ] Full text

National Center for Biotechnology Information

National Library of Medicine 1. Mark the records you need.

2. Click Send to at the top of search results,
then select Citation manager.

coronavirus 3. Select the options.
Advanced - Create alert (g 2 au 4. Click Create file button to input data to
our library.
Save Email Send to y Y
9% 1 re Clioboard X Clear . L
Ipboar Create a file for external citation management software
My Bibliograp y
v
. fs ph}'{lDE Selection: | Selection (2) (83
f
1 Collections en KY.
mite 009 Oct:2:
Citation manager | . 4 ] Cancel
5are -
R £ £=Ta [T ) (=T (N
| 2003, there were only 10 corenaviruses .. L L L L o L L L LD oo o,
to December 2008, there was an addition of 16 coronaviruses ...
2021
H il
Broad-spectrum coronavirus antiviral drug discovery. | Selection (2) v
2 | Totura AL, Bavari S. All results on this page
Cite  Expert Opin Drug Discov. 2019 Apr;14(4):397-412. doi: 10.1080/1746044] All results
a. Selection (2)
Share

PMID: 30849247 Free PMC article. Review,

The highly pathogenic coronaviruses severe acute respiratory syndrome coronavirus (SARS-CoV) and



Direct export: SCOPIIS
Search Sources Lists SciVal @ JAN E Create account

Start exploring

Discover the most reliable, relevant, up-to-date research. All in one place.

fd Documents 2 Authors @ Affiliations Search tips @

Search within
Article title, Abstract, Keywords

+ Add search field [%] Add date range Advanced document search >

v Search documents *

Search History Saved Searches

Start searching and your history will appear here. If you
need help to start searching check out our search tips.



Scopus

196,547 document results

TITLE-ABS-KEY ( coronavirus ) AND ( LIMIT-TO ( PUBYEAR,

2 Edit B Save

Search within results...

L0 Set alert

Refine results

Open Access

[ ]All Open Access

[]Gold

[ ]Hybrid Gold
[ |Bronze

[ ]Green

Learn more

Year

[]2022

N\

(162,607) >
(62,710) >
(13,105) >
(74,979) >
(127,362) >

N\

(17,226) >

Documents

Search Sources

2022 ) OR LIMIT-TO ( PUBYEAR, 2021) OR LIMIT-TO ( PUBYEAR , 2020))

Export document settings @

‘You have chosen to export 196547 documents

Select your methed of export

O & MENDELEY (O Ex|_||ms

Secondary documents

O scival® @ RIS Format
EncNote, Excel

Ocsv OBibTex () Plain Text
ASCIl in HTML

Dalyze se‘results

Reference Manager

What information do you want to export?

[m] Citation information [m] Bibliographical information [] Abstract & keywords [] Funding details [] Other information

[m] Afiiliations

IE Serial identifiers (e.g. ISSN)
[H] PubMed ID

[H] Publisher

[m] Editor(s)

IE Language of original document
[H] Correspondence address

[H] Abbreviated source title

[] Abstract
[] Author keywords
[] Index keywords

[] Number
[] Acronym

[] sponsor
[] Funding text

[] Tradenames & manufacturers
[] Accession numbers & chemicals
[] Conference information

[] Include references

o [m] Author(s)

. [m] Author(s) ID
[®] Document title
[m] Year
[m] EID

[m] Source title
IE volume, issue, pages
[H] Citation count

Document title

IE Source & document type
[H] Publication Stage

=] pol

[H] Open Access

Patient-related outcomes in patients re
clinic with persisting symptoms followi
CQOVID-19

Open Access

Cancel

View abstract v~ View at Publisher Related documents

2022 latreia 0

35(1), pp. 29-39

Mendivelso, F., Guevara,
C., Bernal, L., Lépez, L.,
Low, E.

Negative pressure protective barrier device used in dental
emergencies during the COVID-19 pandemic | [Dispositivo
de barrera protectora con presion negativa utilizado en
urgencias odontologicas durante la pandemia de COVID-19]



by Scopus

e
Export document settings @

You have chosen to export 196547 documents

Select your method of export ‘

(O M MENDELEY (D extibris (O Scival ® | (@ RIS Format (Ocsv (OBibTex (O
Sefirosks EndNote, Excel ASCII in HTML
‘ Reference Manager
What information do you want to export?
: [m] Citation information . [m] Bibliographical information [ ] Abstract & keywords [ ] Funding details [ ] Other information
[m] Author(s) [m] Affiliations [ ] Abstract [ ] Number [ ] Tradenames & manufacturers
[W] Author(s) ID [W] Serial identifiers (e.g. ISSN) [ ] Author keywords [ ] Acronym [ ] Accession numbers & chemicals
[M] Document title [W] PubMed ID [ ] Index keywords [ ] Sponsor [ ] Conference information
(W] Year [W] Publisher [ ] Funding text [ ] Include references

(W] EID

(W] Source title

|§| volume, issue, pages
[m] Citation count

|§| Source & document type
[m] Publication Stage

[m] DOI

[m] Open Access

[W] Editor(s)

|E| Language of original document
[W] Correspondence address

[W] Abbreviated source title

‘lIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII-'
..IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII Il‘

*

.IIIIIIIIIIIIIIIIIIIIIIIIIIIII’

Cancel | Export



Direct export: Google Scholar

®, My profile My library

Google Scholar
B

® Articles Case law
New! Track and manage your public access mandates

Articles about COVID-19

CcDC NEJM JAMA Lancet Cell BMJ

Mature Science Elsevier Oxford Wiley medRxiv

Stand on the shoulders of giants

SIGN IN



= Google Scholar  coronavirus e
1. Click Gite sign at the bottom of a record you need.

Articles About 1,450,000 results (0.03 sec) _ . .
2. Click EndNote button to input data to your library.
Any time Coronavirus
Since 2021 World Health Organization - 2020 - pesquisa.bvsalud.org
Since 2020 Coronaviruses (CoV) are a large family of viruses that cause illness ranging from the
Since 2017 common cold to more severe diseases such as Middle East Ftes;::urat:::try,.r Syndrome (MERS-
Cust CoV) and Severe Acute Rer—"=f-= T domme s SEARE AU B mminl mm e e s oot
ustom range. - Yy U9 Citedby5108 F Cite
Sort by relevance HT™ML] Another decade 1TML] nejm.org
S Perl -2020-M '
Sort by date %ﬁ"? Vel - vass MLA  Perlman, Stanley. "Another decade, another coronavirus."
For t_*hird time in as mar (2020) 760-762
_ hum, 1 opulations. This vil ' '
?nclude pgte_nts Wulesssghina, in persons ¢ APA  Perlman, S. (2020). Another decade, another coronavirus.
¥ include citations ¢ Y9 Cited by 742 Re
_ . , Chicago Perlman, Stanley. "Another decade, another coronavirus.” )
- Coror S rus diseas: (2020 760-762. ’DF] wiley.com
=4 Create alert F He, Y Deng, W Li - Journ
In late December 2019, ac Harvard Perlman, 5., 2020. Another decade, another coronavirus.
Wuhan, China. A few days
identified as a novel coron: Vancouver Perlman S. Another decade, another coronavirus.

¥ UY Cited by 556 R
BibTeX = EndNote  RefMan RefWorks

2
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Select Import Option as PDF

References Groups

Open Library...
Open Shared Library...
Open Recent

Close Library

Save
Save As...

Save a Copy...

Share...

Import

Print...
Print Preview
Print Setup...

Compress Library (.enlx) ...

Exit

Ctrl+0
Ctrtl+Shift+0

Cirl+W

Ctrl+5

Ctrl+P

Ctrl+Q

[ 3

Go to File > Import > File... to open the Import File dialog.

Click Choose to select a PDF file from your hard drive.

Click Import to import a PDF file into your library.

File...

[] '_.;] Open
T D, » ThisPC » Desktop » 2020 v @ £ Search 2020
Organize - Mew folder f==
-
& Mame Date modified

# Quick access R
= Al-Eitan-2020-Bat-Borne Coronaviru.pdf 26-Mar-21 10:57 A...

x

v [N o

Type

Adobe Acrobat D. :

@ OneDrive = Dimonace-2020-Computational Analys.p... 26-Mar-21 11:00 A...  Adobe Acrobat D2
} - - 1 - - ! n

! This PC 3_1 Hasoksuz-2020-Coronaviruses and SA.pdf  26-Mar-21 11:01 A...  Adobe Acrobat D‘...
: 3D Obi "L Keeling-2020-Efficacy of contact.pdf 26-Mar-2111:02 A...  Adobe Acrobat D=
ects N =

: "L Khan-2020-Emergence of a Movel pdf 26-Mar-2111:02 A...  Adobe Acrobat D.m

[ Desktop -
|| 2020 -

v £ »"

- u

u

File name: ~| | Files () v o=

u

| Open | | Cancel | :

Ll

"

Import File

Al-Eitan-2020-Bat-Borne Coronaviru,
Import File I P

S 0—

Duplicates

Text Translation: No Translation




Import PDF File (2)

EndNote 20 - SCBM496_1111111.enl

File Edit References Groups Library Tools Window

© Sync Configuration

[E All References 11

& Imported Referen... 1

Recently A
B Unfiled

Help

Imported References

Advanced search

Imported References

1 Reference

AQ@

W Trash
MY GROUPS
v My Groups
FIND FULL TEXT
GROUPS SHARE...
ONLINE SEARCH +
@ Jisc Library Hub ...
@ Library of Congr...

@ PubMed (NLM)
® Web of Science ...

Search for group

‘ Author

¢ Harshani Nadeeshani; Jinyao Li; T...

‘ Year ‘ Title
2022 Nicotinamide mononucleotide (NMN)...

E Nadeeshani, 2022 #67 Summary Edit PDF X
QB ~1]/12v —[e7% ]|+ D cC =Y=Nrd
1-s2.0-52090123221001491-main.pdf v
Lﬁj Journal of Advanced Research
Nicotinamide mononucleotide (NMN) as an anti-aging health product - | &

Promises and safety concerns

Harshani Nadeeshani”, Jinyao Li", Tianlei Ying ", Baohong Zhang ", Jun Lu =

HIGCHLIGHTS CRAPHICAL ABSTRACT

< . —*

ABSTRACT




M 0 Dd o~

Go to File > Import > Folder... to open the Import File dialog.

Click Choose to select the PDF folder from your hard drive. (additional settings as needed.)

Select Import Option as PDF.

Click Import to import the PDF files from the selected folder into your library.

References Groups

Open Library...
Open Shared Library...
Open Recent

Close Library

Save
Save As..,
Save a Copy..

Share...

Print...
Print Preview
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® New Terms appear in red text.
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[} EN Go to EndNote Style: |Vancouver -
| (?t‘ @' Edit & Manage Citation(s) LE,' Update Citations and Bibliography
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Citation « L3 Edit Library Referencef(s) B Convert Citations and Bibliography ~

1 ) |3—‘b, Insert Citation... Bibliography

Instan’

|Z_I’Q Insert Selected Citation(s)
E Insert Note...

!c: Insert Figure...

Open the Word document and position the cursor at the location
where you would insert the citation.
1. Go to EndNote 21 menu, select Insert Citation to display the
Find & Insert My References box.
2. Inthe text box at the top, enter text to find the reference you
wish to cite, then click Find or press Enter.
Select the desired references from search result.
Click Insert.

The inserted citation would appear in your manuscript.

EndNote 21 Find & Insert My References X
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Author Year Title "

Fishing Technique of Long-Fingered Bats Was Developed from a Primary Reaction to Disappearing Target Stimuli
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Fraser 2011 Ravens Recondile after Aggressive Conflicts with Valuable Partners

Fujioka 2014 Rapid shifts of sonar attention by Pipistrellus abramus during natural hunting for multiple prey

Gorresen 2018 Multi-state occupancy models of foraging habitat use by the Hawalian hoary bat (Lasiurus cinereus semotus)

Holland 2008 Bats use magnetite to detect the earth's magnetic field

Koepke 2015 Delayed Gratification: A Grey Parrot (Psittacus erithacus) Will Wait for a Better Reward
Patterson 1994 A COMPARATIVE-STUDY OF HUMAN AND PARROT PHONATION - ACOUSTIC AND ARTICULATORY CORRELA1
Patterson 1998 Acoustic and articulatory correlates of stop consonants in a parrot and a human subject
Pepperberg 1981 FUNCTIONAL VOCALIZATIONS BY AN AFRICAN GREY PARROT (PSITTACUS-ERITHACUS)
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Title: Fishing Technique of Long-Fingered Bats Was Developed from a Primary Reaction to Disappearing Target Stimuli
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Library: My EndNote Library.enl
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Open the Word document and position the cursor at the

location where you would insert the citation.

1. Go to EndNote 21 menu, select Go to EndNote.
At your EndNote library, select the desired references.

3. Go to Endnote’s Tools menu, select
Cite While You Write [CWYW] > Insert Selected Citation(s)

The inserted citation would appear in your manuscript.
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2 Voss,R.S..... 2016

Chiy, C; M... 2007

4
4
4
Advanced search
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s
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Pepperber... 1986 SENSITIVE PERIODS, SO... Behavioral an... 8/3/2021
Open the Word document and position the cursor at

. _ o 2 Roosting Ecology of Am...  American Mu...  8/3/2021
the location where you would insert the citation.

Chiu, C; M... 2007 The role of the external ...  J Acoust Soc ...  8/3/2021

1. Go to EndNote 21 menu, select Go to EndNote.

. . > s EndNoteTraining_KN.d - Word
2. At your EndNote library, select the desired H S0 g —
references File Home Insert Draw Design Layout References Mailings Review View Help EndNote 21
EN Go to EndNote Style:  |Vancouver - iﬂ- Categorize References ~ ‘@ Export to EndN
3. Return to Word document. Go to EndNote 21 E”
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T nse ==
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File Home Insert Draw Design Layout References Mailings Review View Zotero Help EndNote 21
L} EN Go to EndNote Style:  |Vancouver - @-Categorize References ~ #2 Exnort to EndNote v 4P
Q F‘F’. Edit & Manage Citation(S) I?‘ w u‘ul.':.‘ SllaLu s ﬂll\li LJI;J;IU 1a ;I '? ;ll-)tulll- I_ullllul.l.;ll ;.) '> 1 EndNOte 21 Edit & Manage Citations ><
Insert il FHEry = 7 | citation - Count  Library
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Citations Bibliography . . Aizpurua, 2016 #17 1 My EndNote Library Edit Reference| ~
(2.3) Edit Library Reference
4 Pepperberg, 2013 #137 1 My EndMote Library 2 Find Reference Updates...
1. Go to EndNote 21 menu, select Edit & Manage Citation(s) to display *) | Patterson, 1998 #66 1 My EndNote Library SRR
. . . ) Insert Citation
EndNote 21 Edit & Manage Citations box. Voss, 2016 #198 My EndNote Library PN
2. You can add or remove citation from multiple citations or change the order
of citations.
* Edit Library Reference: select this command to directly edit the Edit Citation Reference
. . Formatting: | Default v
corresponding references in EndNote.
Prefix:
®* Insert: Use this to add another citation within the same set of delimiters. Suffix
®* Remove: Highlight a citation and click Remove to delete it from the Pages:

in-text citation.
* Up and Down Arrows: Highlight a reference and use the arrows to
change the order of display.
3. Click OKto implement your changes. fods ~ 8 o | o Help

Totals: 3 Citation Groups, 4 Citations, 4 References
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EndNote 21 Edit & Manage Citations
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Citation Count
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B B 2izpurua, 2016 #17
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Pepperberg, 2013 #137 1
Patterson, 1998 #66 1
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Voss, 2016 #198 1
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My EndNote Library Edit Reference| =
My EndNote Library Edit Reference| =
My EndNote Library Edit Reference| =

Edit Reference| =

Edit Citation Reference
Formatting: | Default ~
Prefix:

Suffix:

Pages:

| Configure Bibliography
| Export Traveling Library
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Tools 1

Totals: 3 Citation Groups, 4 Citations, 4 References

Help

EndNote 21 Configure Bibliography

Format Bibliograph  Layout 2

Font: Size:

Times New Roman ~ 12 v

Bibliography title:

REFERENCES

Text Format...

Start with bibliography number:

First line indent: | 0.000 in Line spacing: | Single M
Hanging indent: | 0.500 in Space after:  |None v

3 oK Cancel Help

From EndNote 21 Edit & Manage

Citations box, click at Tools menu at

the lower left corner, select Configure

Bibliography

On the Layout tab, you can change or

verify these settings:

® Font and Size: these are the text
font and size used for the
bibliography.

® Bibliography Title: to print a title at
the top of your bibliography, type
the title in this text box.

® Text Format: highlight the
bibliography title text and then use
the Text Format button to display a
dialog where you can change the
format of the highlighted text.

Click OK to implement your changes.
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Convert Reference Manager Citations to EndNote

EEI Convert Word Citations to EndNote

You may need to remove ‘Cite While You Write’ field codes in order to

EndNote 21 X share your document with a publisher or colleague. Convert to Plain Text will save a

copy of your document without formatted ‘Cite While You Write’ field codes. The

This command will create a new copy of your Word document

| and remove all special EndNote markers from it. The new formatted citations and the bibliography are saved as text. By following the steps;
document will appear in a new unsaved document window.
The original file will remain opened and untouched. 1 Go to EndNote 21 menu. select

Do you wish to continue?

Convert Citations and Bibliography > Convert to Plain Text

Cancel

) IT 2. Word presents the notification box, read and click OK to continue.

3. A copy of the document, without field codes will appears in a new document

window. Then you can save a new name for copy of your document.



